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Mail Designer: Tutorial Videos
Click the links below to watch Mail Designer tutorial videos, or visit equinux.com/support/maildesigner
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The Design Chooser
Create a new mail using a Design Idea, tweak an existing stationery template or pick one of your saved designs to send.
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Choose a design idea 
as a starting point for 
your design

Start working on a new 
design based on the 
selected design idea

Access the design cate-
gories you have in Mail

Take a look at the 
additional Stationery 
Packs we offer for more 
inspiration

Any mail designs you 
create will show up here

Use the zoom slider to 
take a closer look at the 
designs



Mail Designer at a glance
Add images, edit text and re-arrange your layout – in the main document window.

 6

Click here to go back 
to the Design Chooser 
to pick a new design 
to work on.

This is the distance be-
tween the element 
you’ve selected and the 
element your mouse is 
pointing at – handy for 
pixel-perfect adjust-
ments.

Quickly adjust your font, 
text spacing and other 
options using the font-
popover.

Grab a layout block by 
its handle and just drag 
‘n drop to rearrange 
your layout.

Change the background 
color or add a back-
ground pattern and give 
your design a whole 
new look.

Hit ‘Send’ to open and 
send your design with 
Mail.

Show or hide the layout, distance indicators or rulers.



The contents window
Drag and drop new layout elements, graphics, text objects, placeholders, background patterns and photos into your design.
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To add a layout 
block to a design,  
just drag and drop 
it into your design.

Drag graphics to 
your design and 
double-click the 
text to write your 
own.

Switch to back-
ground mode and 
drag in the texture 
you prefer.

Use image 
placeholders to 
add picture 
frame 
effects, or to 
resize or crop 
your images. 
You can also 
replace place-
holders later in 
Mail.

Choose a text style, 
drag it into your 
design and then 
double-click to 
write your own text. Add your own 

pictures from 
iPhoto, or your 
logos and signa-
ture from a folder.



Your first mail design
To get you started, we’re going to design a new email step-
by-step, explaining the options in detail as we go.

Creating a new design
We’re going to create an email design for a small business. As an example, 
we're going to use a local guitar shop, Jim’s Guitars.

The owner, Jim, likes to keep his loyal customers up-to-date with the latest 
guitar news and offers. We’re going to use Mail Designer to design a custom 
newsletter that Jim can use to keep in touch with his customers. 

Mail Designer includes several “Design Ideas” – common email layouts that 
can be used as a starting point for a new email. Since we want to have a 
fairly simple, clean look, we'll start off with the "Prospectus" template. Just 
double-click a design in the chooser window to create a new design based 
on that design idea.

The design will open in a new window, ready for you to start editing:
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Working with layout blocks

First, make sure you can see the layout by clicking 
the “Layout” button in the toolbar. Click the Lay-
out button to show or hide the frames around the 
stationery’s layout blocks.

You’ll notice a translucent tab attached to the left 
side of each block.  Those are the layout block 
“handles”, each individual layout block has one. You 
can rearrange a layout block by grabbing its handle 
and dragging the layout block into another posi-
tion.

Layout blocks: working with text and image areas

Mail Designer offers layout blocks that have text areas, image areas or both.  
A text area can only contain text, while an image area can contain images, 
photos, placeholders and styled text. 

Layout block “handles”

Layout block with text and image areasA layout block with text, text with 
background  and image areas

Layout block with text areaLayout block with an image area

Adding layout blocks

Click the “Contents” button to open the Contents panel. This contains all the 
design elements you can add to your Mail Design. Go to “Layout Blocks”, 
choose one and drag it to your Mail Design. The other layout sections will 
slide out of the way so you can drop in the new layout block.

Drag a layout block into your design. 

The other blocks will slide out of the way and you can drop the new layout block into place.
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Removing layout blocks

Click the “x” icon on the layout block “handle” to 
delete a layout block. 

Adding space in-between layout blocks

You'll notice that your new layout block is very 
close to the top of the next layout block. This makes 
the design feel a bit cramped, so we need to add a 
bit of space in between the two blocks.

Go back to the Contents panel and drag the spac-
ing layout block in-between the two content lay-
out blocks.

Click “x” to delete

We need to add space in-between these two layout blocks

You can then fine-tune the size of the divider by dragging the line above or 
between it - it should look right with about 30 pixels between the two layout 
blocks.

Duplicating layout blocks

If you are setting up multiple similar layout blocks, it may be easier to dupli-
cate an existing layout block instead of choosing your font and color options 
again.

There are two ways you can duplicate layout blocks. 

‣ Click the selection tab at the side of a layout block and choose “Edit > Du-
plicate” from the menu bar

Click the selection 
tab to choose a 
layout block - then 
choose Duplicate 
from the Edit menu
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‣ Hold down the option key on your keyboard and click and drag a layout 
block. 

Drop it into position to create a copy of that layout block. Then edit your text 
and other options accordingly.

Adjusting the size of areas within a layout block

You can also adjust the width and height of layout blocks, or of sections 
within a layout block as well. 

Just drag the dividers to adjust the width of a section within a layout block.

In a text area, you can adjust the height by adding or deleting lines of text.

In an image area, drag the dividers to adjust the height of the area.
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Choosing a background
There's a paint roller icon in the lower left corner of the window. Click it to 
switch to the background editing mode.  When choosing a background, you 
will see two areas: the background of your text areas in the middle of your 
design and the surrounding background area:

Click the 'Textures' or the 'Colors' icons to choose a 
background texture or a single background color to 
apply to your design. 

Click the paint roller 
icon to switch be-
tween background 
and layout views

Choose a texture or color

Drag a color or tex-
ture to this area to 
set your main back-
ground

Drag a color or tex-
ture to the inner 
area of your design, 
to choose a back-
ground for your text 
areas

Choose a texture or color

To apply a background color

Click the "Color" bucket icon to open the color picker window. Click a color 
or drag it onto the background to apply it.
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To apply a background texture

For our email, we're going to use a dark black background wallpaper texture.

Click the paint roller icon to switch to background mode: 

 

Next, click the textures icon to bring up the Contents panel and open the 
background textures. Then drag a texture to your background to apply it. 

 

Custom backgrounds
You can also use one of your own photos or texture images as a 
background: choose the “Photos” section in the Contents panel and 
drag your photo or texture image to the background to apply it.

Alternatively, drag in an image from the Finder, or copy and paste a 
image to set your background.
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Applying a background to a text area
You can also choose a background texture or background color for the text 
areas in your design.

Choosing a background for all text areas

Switch to background mode by clicking the paint roller icon in the bottom 
left corner of your design. Apply a background to the middle area to apply it 
to all of the text areas in your design.

Choosing a background for a single text area

Choose a layout block area and click the background paint roller icon for 
that layout block. Now you can choose to apply (or remove) a background 
for just that text area.

Applying a background to a text column

Some text areas can be assigned a separate 
background. This can be used to create side-
bars with links or other at-a-glance informa-
tion.

Text areas that support backgrounds are high-
lighted in green in the Contents panel.

Applying a background to an image area
You can also change the backgrounds of image areas individually. Select an 
image area and click the paint roller icon to switch to background mode. 
Then drag a background texture or color into the image area to apply it.

A layout block with a text area that 
uses a custom background

Creating transparent background effects
If you would like to create design effects by giving some layout blocks a 
“transparent” background, try this:

‣ Click the paint roller icon in the bottom left corner of your document
‣ Choose the middle background for all text areas
‣ Right-click and choose “Delete Background” from the shortcut menu

Now all of your text areas will appear with no background. Leave back-
ground selection and now selectively apply a background to all layout 
blocks, expect those that you wish to remain “transparent”:

‣ Choose layout blocks, except those that are to appear “transparent”
‣ Click their individual paint roller icons
‣ Apply a background

Example

In this example, a white background has been applied to all layout blocks, 
expect the “Jim’s Guitar News” header, allowing it to appear as though it is 
floating above the rest of the content.
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Working with image areas
Image areas can contain images, photos, placeholders and stylized text – so 
you can really let your creativity flow.

Image areas are highlighted in blue in the Contents panel:

You can drag graphics, image placeholders, photos and stylized text to these 
areas in your design. Mail Designer will highlight those areas that you can 
drop images into.

Layout block with text and image areasLayout block with an image area

Graphics and other objects
Mail Designer includes graphics that you can use to spruce up your email 
design. These include sales promotion artwork as well as border designs.

Adding objects

To add graphics or another object, simply choose one from the Contents 
panel and drag it into an image area in your mail design.

Duplicating objects

You can duplicate objects by choosing Edit > 
Duplicate from the menu bar. Alternatively, 
you can also hold down the option key and 
drag the object to place a duplicate in your 
design.

Hold down the Option key and 
drag to duplicate an object
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Resizing objects

You can also resize and adjust graphics using the resize controls. Click a 
graphic to see the resize controls. 

Then just drag the graphic to the size you would like it to be. 

Resizing from the center

If you hold down the option key while resizing a graphic, it will be resized 
evenly from the center (i.e. it will be resized in from the edge you’re dragging 
as well as from the opposite edge).

Resizing without constraining proportions

Ordinarily, Mail Designer preserves the proportions of a graphic when you 
resize it. However, you can also optionally also choose to disregard the pro-
portions while resizing. 

Hold down the Command key and resize a graphic or image to resize it 
without preserving its proportions.

Adjust the size of graphics using 
the resize controls

Hold down the Command or Option keys while resizing for more options

Using objects with text

Some of the objects may contain text. You can double-click the text to re-
place it with your own.

We’re going to use one of these graphics to create a cool header for our Mail 
Design.

Choose “Graphics” in the Contents panel and choose the red “Newsletter” 
image and drag it into the header section:

Double-click the “Newsletter” text and we can type in a custom name. You 
can also choose to a font and make it bigger or smaller to fit the available 
space:
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Photos
As everyone knows, a picture is worth a thousand words. Photos are a great 
way to grab your readers attention and immediately let them know what the 
email is about.

Adding photos

Open the Contents panel and choose "Photos". The photos tab gives you 
quick access your iPhoto and Aperture libraries, as well as other folders that 
contain images.

To add an image, just drag it into an image area. 

Once you've dragged your image into an image area, you can use the or-
ange resize controls along the edge of your picture to resize it.

Image Placeholders

For greater flexibility, Mail Designer also includes image placeholders that 
can be used to crop or resize a picture and also offer interesting frame de-
signs and masking effects.

Open the Image placeholders tab in the 
content window. Mail Designer includes 
plain placeholders, framed placeholders and 
even masking effect placeholders, like the t-
shirt or flag designs.

Adding an image placeholder

Pick the image placeholder style that you 
would like to use and drag it into your de-
sign. You'll notice that Mail Designer has 
highlighted the image areas again, so you 
know which areas you can add your place-
holder to. 

This blue rectangle is the image placeholder we have added. It will show up 
in Mail as a blank area that you can use to drop your own images or photos 
onto. 
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Pre-filling an image placeholder

You can also pre-fill an image placeholder – this image will show up even if 
you don't add your own photo to a placeholder in Mail. Confused yet? Don't 
worry, it'll make sense once you see it 
in action. 

Double-click the image placeholder 
we just added. You'll see the image 
zoom slider show up underneath, so 
you'll know you can now pre-define 
this image placeholder's image.

Now, just drag a photo onto this image 
placeholder and it will be set as the default image for this particular image 
placeholder. You can always replace this image later in Mail.

Adding your own logos and signatures

You probably have logos or a scan of your signature that you would like to 
frequently use in a your mails designs. 

You can add these to the “Photos” section of the Contents panel, so you’ll be 
able to get to them faster.

Go to the Photos section and 
right-click underneath the pre-
defined folders that are listed. 
Then choose a folder with your 
images that you would like to 
add.

There you go! Now you can easily access your logos and other company im-
ages directly within the Contents panel.
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Working with text
With the design more or less complete, it's now time to work on the text of 
your email. Mail Designer makes it easy to create an email that you can then 
tweak and adjust in Mail for individual recipients, without requiring you to 
re-enter boilerplate text (e.g. contact details, product description signature, 
website link) every time you send an email.

Editing a text area

To edit a text area in your message, just click inside a text area and start typ-
ing – simple! You can also adjust your font and text flow options by selecting 
text and choosing your options from the popover.

For now, I'm just going to enter a rough draft of my text and I'll do the fine-
tuning later when I send this message using Mail.

What can text areas do?
There are two kinds of layout blocks in Mail Designer: text areas and 
image areas. Image areas can contain both text and images, while 
text areas can only include text.

You can edit a text area later in Mail, whereas text in image areas can 
only be altered in Mail Designer.

Copy and Paste Style

If you have added additional layout elements, you may want to copy and 
paste your existing font style into your new layout elements.

To copy and paste a text style

Select the text that has the style you would like to copy, then right-click and 
choose “Copy Style”.  

Then choose the text you would like to apply the copied style to, right-click 
and select “Paste Style”:

There you go: the text style (including font option, text color and bold set-
tings) has been pasted onto your new text:
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Paste text and keep style

Any text you paste into Mail Designer will automatically receive the style of 
the text area you’re pasting in to.

If you would like to preserve your text style, you can use the “Paste with 
Style” command instead.

To paste and preserve the original style of your text

‣ Copy text that has formatting you want to preserve
‣ Choose “Edit > Paste With Style” from the menu bar

A note about font options
If you're in a text area, the font options in the popover only include 
so-called "web-safe fonts". These are fonts that can be viewed on 
most computers. If you're adding text to an image area, you can 
choose from a wider selection of fonts, as these will be displayed as 
part of an image, ensuring their compatibility with most email pro-
grams.

Editing text in an image area

In an image area, Mail Designer offers more flexibility and you can get really 
creative with your text. Let's try out some creative ideas!

Open the Contents panel and choose "Text objects".

First, we have the plain-jane "Sans" 
and "Serif" text elements that you can 
drag in to an image area to enter basic 
text. Click and drag the text box 
around to position it the way you 
want and choose your font and text 
alignment options as before.

We have also created a few other text 
styles using different fonts and colors.

Drag any of these text objects into an 
image area and double-click it to edit 
the  text.

Special Characters
You’ll notice that some of the text objects use special characters like 

these: ★  ♫. 

You can find lots more of these types of characters under “Edit > 
Special Characters…”

Select text somewhere in an image area, choose a special character 
and click “Insert” to add it to your text.
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Working with links
You can include links to your website, file downloads or other resources on 
the web in your design. Mail Designer support links for image areas as well 
as text links.

Creating a text link

Mark the text that you would like to turn into a link. Then click the arrow link 
in the popover. A dialog will slide in and you can enter your link.

Then enter your URL in the Link destination dialog box:

Note: you can change the color and text options of your link using the regu-
lar font options.

Select some text 
and click the link 
button.

Creating an image link

You can create a link with an image area, so the image area will be clickable 
in your email. It’s important to note,  that as an entire image areas will be 
displayed as a single image in your email, you can only assign one link per 
image area. 

To create an image area link, choose an image area in your design and click 
the arrow link button from the popover. Then just enter your URL. The entire 
image area will be “hot” and can be clicked in your final message.

Multiple links
We’ve included several layout blocks that contain several image ar-
eas next to each other. 

You can use these blocks to create multiple image area links, e.g. in 
order to use multiple buttons with links to social media sites.
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Saving and sending messages
Saving your design
Once your design is finished, you can save it to re-use later.

Choose “File > Save” from the menu bar. You can give your new stationery a 
name and choose a new or previously existing category to save it in:

You’ll find your design in the Design Chooser under the category you saved 
it in, or you can also see all the designs you’ve created under “My Designs”. 

Choose your design and click “Edit” to edit or send that design.

Sending emails with your design
With the final graphical touches added, our email design is ready to be sent. 
There are two ways you can go about sending messages:

Preparing your message

Click the Send button in the toolbar to open your design in Apple Mail. You 
may notice Mail briefly quits and re-opens, in order to allow Mail Designer to 
add your new design to Mail.

Your design will be opened in a new Mail compose window. You now have 
an opportunity to change the text and replace any image placeholders you 
may have in your Mail Design.

Accessing designs in Mail

You can also open your design directly from within Apple Mail. Open a New 
Message window and click “Show Stationery”. Then, scroll to the category 
your picked to open your design.
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To edit or replace your text

Click into one of the text areas. You’ll notice that Mail has selected the entire 
block of text. Press the right arrow key on your keyboard once. You can now 
use the arrow keys to move the cursor into the position you want to start 
editing your text:

You may find it easier to write your entire message in Mail Designer, rather 
than in the Mail application. Just choose your saved design in Mail Designer, 
edit your text and hit “Send”. 

Tip
If you start typing while the entire block of text is selected, you’ll de-
lete your entire placeholder text. If you accidentally cleared your 
text, just hit Command+Z on your keyboard to undo and restore 
your placeholder text.

To replace a placeholder image

If you have image placeholders in your design, you now also have the option 
of replacing your placeholder images.

Just drag a photo or image into the placeholder. 

Resizing images

If you notice that your new photo isn’t quite the right size for your place-
holders, just click it once to bring up Mail’s image resizing controls. Drag the 
zoom slider to zoom your image in or out. 

You can also click and drag your image to re-position it in the placeholders, 
e.g. to focus on another part of the image. 

 23



Advanced design techniques
We’ve covered the basic, so let’s look at some of the slightly 
more advanced layout and design techniques you can apply 
to your email designs.

Combining design elements
You can create some interesting effects by combining multiple design ele-
ments. Mail Designer can arrange objects in layers, so you can stack objects 
on top of each other for eye-catching looks.

Combining graphics

Let’s say we have a big sales event on July 16th that we want to announce. 
We can highlight that date visually by combining the calendar text element 
with a graphic element to highlight the specific date.

Drag in the July Calendar text object:

Now go to the graphics and drag the black marker circle onto the calendar:

Finally, grab the black circle by the orange adjustment handles, resize it, and 
then click and drag it into position over July 16th.

Perfect! A great visual reminder to let customers know to check out the 
event on July 16th!
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Moving objects to the front or back
Once you start combining design elements, you may want to place certain 
objects in image areas in front of or behind other objects.

Moving objects

Select an object and click the “Front” or “Back” 
button in the toolbar. For more granular control 
over your layers, you can also choose  “Arrange > 
Bring Forward” or  “Send Backward” from the 
menu bar.

For instance, in order to place this “May edition” text object in front of the 
“Newsletter” banner, I right-click it and choose “Bring forward”:

That will place it in front of the “Newsletter” banner:

Grouping designs elements
You can also group design elements together, making it easier to move ele-
ments that belong together around in your design.

To group elements together

Drag across two or more elements to select them together and then choose 
“Group” from the toolbar. Here I’ve selected three elements: the “Sale” text, 
the description and price and the strikethrough line:

You can now move the elements around together,  and they’ll be treated as 
one single element, making it much easier to move them around in my de-
sign:

Ungroup the included text objects
Several of the text objects that we include are images and text ob-
jects grouped together. You can ungroup these for greater control 
over the look of a certain element – just select “Ungroup” from the 
toolbar.
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Using text placeholders
Mail Designer has the ability to use placeholders for text, so common snip-
pets such as your name or the date can automatically be inserted into your 
email text.

Adding text placeholders

Choose “Insert” in the menu bar and choose one of the five available place-
holders: Full Name, First Name, Email, Short Date or Long Date.

Alternatively, you can also right-click and insert a placeholder:

While layout view is enabled, you’ll be shown the text placeholder. Turn off 
layout view to see the final text.

You can choose from one of the following placeholders:

Placeholder Inserts

Full Name The sender’s full name as set in the 
Address Book

First Name The sender’s first name as set in 
Address Book

Email The sender’s email address as set in 
Address Book

Short Date Today’s date in short form (e.g. 
07.06.2011). The date formatting is 
determined by your System 
Preferences.

Long Date Today’s date in long form (e.g. 
Friday, 15. July 2011). The date 
formatting is determined by your 
System Preferences.

Once inserted, the placeholder will be automatically replaced once you go 
to send your message in Mail:
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Editing Business Edition stationery
If you own Stationery Pack Business Edition, you can also 
adjust and save personalized copies of those templates.

Most businesses frequently need to send out the same email, with only mi-
nor changes in the content. Now there is a way to write an email once and 
then save that email as a new template for easy re-use in Mail.

We’ve updated your Business Edition templates so they can be edited and 
customized with Mail Designer.

You can customize:

• The layout of the email

• Text and font options (including disclaimers, contact details, etc.)

• Photos and image placeholders

You won’t be able to easily change backgrounds or certain graphics.

If you find yourself running into limitations when trying to edit a Stationery 
Pack design, you may want to try creating a similar design using a Design 
Idea instead.

More Designs?
Click the “Stationery Pack” heading to see all the Stationery Packs 
equinux has to offer. 

You can choose templates from Packs you have purchased or dis-
cover and preview new Packs. You’ll be able to edit the text and pho-
tos in other templates, however the layout will be fixed.

How to customize a Business Edition design
In the Design Chooser window, look under the “My Library” heading. Those 
are all of the stationery pack templates you currently have in Mail. 

Pick a Business Edition stationery design and choose “Edit a Copy”.

Edit the layout, your text and image placeholders in the email and choose 
“File > Save”.  Pick a name for your edited template and choose the category 
you would like to save it in.

You’ll now be able to access this edited template and send it out without 
having to make major changes every time you want to use it.
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Sharing your designs
Share your latest stationery with your friends and 
colleagues, so they can send their own messages based on 
your designs.

Mail designer offers several ways of sharing your design.

Share as Mail Designer Document

This option will create a file that can be opened in Mail Designer on another 
Mac. This gives you more flexibility, but also means you'll need to have Mail 
Designer installed on the Mac you send the file to. 

Share as Apple Mail Stationery

If you choose this option, Mail Designer will create a file that can be opened 
in Apple Mail and doesn't require Mail Designer to be installed.

Choose Share from the menu bar to export or email your design. 

The person opening the design will be asked to pick a category for the new 
design. Once it’s been added to Mail Designer or Apple Mail, they’ll be able 
to send their own emails, based on your design.
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HTML Export
Mail Designer can export a HTML file containing your 
design. You can re-use your design with other services, or 
publish a copy as a webpage.

Once you have created your design, you can export it as HTML. This will al-
low you to do even more with your design:

• Upload your design to third-party newsletter services

• Offer readers with email programs that don’t support HTML the option to 
view your message as a webpage in their browser

• Link to your newsletter directly from your website, for people that would 
like to see a newsletter before they subscribe

To export your design as a HTML document

‣ Open your design
‣ Choose “Share > HTML…” from the menu bar

‣ Choose a location to save your design
‣ Optional: If you plan on uploading your images to a separate web server, 

you can enter an absolute URL prefix for images.

Mail Designer will create a folder containing the HTML file and images that 
make up your newsletter. 

Offering your newsletter on the web
You can upload the exported HTML and image files to a web host. This 
would allow your readers to open your message in their web browser. This 
can be be used to give readers an alternative way to read your message, if 
their email application doesn’t support advanced HTML messages.

To offer your newsletter on the web:

‣ Export your design as a HTML document
‣ Upload the exported folder to a web server (via FTP, or tools offered by 

your host)
‣ Add a link to the web version of your newsletter in your email
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Export to other Email Marketing Tools
There are dozens of email and newsletter services that support HTML emails.

If your newsletter provider supports custom HTML templates with images, 
you may be able to export your design from Mail Designer and import into 
into your tool of choice.

Preparing your design for import

Depending on your service, you may need to do import your design in one 
of the following ways:

‣ Create and upload a compressed zip archive containing all of the files you 
exported from Mail Designer

‣ Upload your HTML file and a separate zip file containing all of your images
‣ Copy & paste the contents of your HTML file and upload your images
‣ Upload all of the exported files individually

Getting help with other email marketing tools
This manual Can only outline the basic steps required to upload a 
design to a email marketing tool. As every newsletter service works 
differently, you’ll need to consult the documentation provided by 
your newsletter service to see if it is possible to import custom HTML 
templates and how they recommend you upload your design.

Example: Campaign Monitor

Here we’ll show you how to use a design with Campaign Monitor.

How to upload your HTML export to Campaign Monitor

‣ Export your design using Mail Designer’s HTML export
‣ Go to the folder with your exported design
‣ Select the image files in your exported design folder and create an archive 

containing all the .jpeg and .png files

‣ Sign in to your Campaign Monitor account
‣ Go to the Templates section and create a new template
‣ Choose the “content.html” file in the folder with your exported design and 

upload it as your HTML page in Campaign Monitor
‣ Choose the zip archive you create earlier and upload it 
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Exporting a Design to MailChimp
If you’ve created a newsletter design that you want to email 
to large number of users, you might want to send it out with 
MailChimp – a professional email marketing service.

While you can send your newsletter directly to your readers from Apple Mail, 
most email providers won’t allow you to send emails to hundreds or thou-
sands of readers at a time. That’s where MailChimp comes in. This service can 
send emails to large numbers of newsletter subscribers at a time. 

MailChimp offers free accounts to get you 
started, with paid accounts available for 
users with larger numbers of subscribers.

To start using MailChimp

First you’ll need a free MailChimp account, so head over to their website to 
sign up:

→ http://www.equinux.com/goto/maildesigner-mailchimp-signup

Once you have a MailChimp account, open one of your templates in Mail 
Designer and choose “MailChimp template” from the share menu:

You’ll be asked to enter your MailChimp API key:

To add your API key:

‣ Go to the MailChimp website and sign in to your MailChimp account
‣ Choose “Account > API keys & authorized apps” from the menu
‣ Copy your API key
‣ Paste it into Mail Designer

Mail Designer can store your API key in your keychain, so you should only 
need to set this up once.

API Key?
In order to add new templates to your MailChimp account, Mail 
Designer needs your MailChimp account API key, which will allow it 
to upload templates on your behalf.
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Uploading a design to MailChimp

Once your account has been configured, your designs can be uploaded to 
your MailChimp account. Choose a name to save your design as and click 
export:

Your design will then be uploaded to your MailChimp account. You can then 
view it on the MailChimp website to see how it looks and use the new tem-
plate in your MailChimp marketing campaigns.

MailChimp Editing and Compatibility
Editing

MailChimp also offers an online editing tool. However, it is usually easier to 
use Mail Designer for all editing and to simply upload your edited document 
when you’re finished.

Just be sure to export your edited template with a new name, as Mail 
Designer can’t overwrite templates already uploaded to MailChimp.

Compatibility

When Mail Designer documents are exported to MailChimp, the HTML for-
matting is re-interpreted by MailChimp’s HTML engine. 

We have tested compatibility thoroughly and have strived to ensure that 
designs are exported as accurately as possible.

However, it is possible that you may see some minor discrepancies with re-
gards to the exact flow and formatting of your text (e.g. a paragraph may 
take up four lines of text instead of three) and MailChimp’s editing preview 
can also sometimes display things slightly differently. 

For a more precise preview, use MailChimp’s  “popup preview” feature or 
send yourself a test message through MailChimp once you have created 
your campaign, before sending it to recipients.
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Using placeholders with MailChimp
MailChimp can use “placeholders” or “merge tags” in your design to auto-
matically insert personalized details into your message.

To use MailChimp placeholders

‣ Go to a text area within your design
‣ Right-click and choose “Insert Placeholder > MailChimp “
‣ Choose the placeholder you would like to add
A placeholder will be inserted into your text, which will later be replaced 
with information from your MailChimp account.

MailChimp placeholders explained

Placeholder Description

Address and vCard Your details, as stored in your 
MailChimp account. 

Includes your address and a 
download link for your vCard

Current Year Inserts the current year

Date Inserts the current date

First Name Adds the recipients first name

Forward Include a link that can be clicked for 
forward your newsletter to other 
recipients

Last Name Adds the recipients last name

List Address Adds your address, as stored for a 
particular list

List Company Adds your company name, as 
stored for a particular list

List Description Includes a description of why your 
customers are receiving this email, 
as stored for a particular list.

List Phone Include your phone number, as 
stored for a particular list

Recipients Email Adds the recipients email address

Unsubscribe Adds an unsubscribe link

User Address Add your postal address, as stored 
in your MailChimp account

User Company Add your company name, as stored 
in your MailChimp account
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Placeholder Description

User Phone Add your phone number, as stored 
in your MailChimp account

More on MailChimp
This manual covers the basic steps required to upload your design as 
a MailChimp template. 

To learn more about the other MailChimp features (e.g. managing 
recipient lists, using merge tags, customizing the MailChimp footer 
at the bottom of emails), please visit the MailChimp support pages 
for detailed information:

→ http://www.equinux.com/goto/mailchimpsupport
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Exporting a Design to 
Campaign Monitor
Campaign Monitor makes it easy to send email newsletters 
to a large number of users and is also ideal if you’re 
designing newsletters for clients. Export your design 
directly from Mail Designer.

While you can send your newsletter directly to your readers from Apple Mail, 
most email providers won’t allow you to send emails to hundreds or thou-
sands of readers at a time.  With Campaign Monitor you can send your 
emails to large numbers of newsletter subscribers at a time. 

Campaign Monitor offers different packages that allow 
you to send a certain amount of messages. You can ei-
ther pay monthly or pay by campaign.

To start using Campaign Monitor

First you’ll need a Campaign Monitor account, so head 
over to their website to sign up:

→ http://www.equinux.com/goto/maildesigner/plugins/campaignmonitor/signup

Once you have a Campaign Monitor account, open one of your templates in 
Mail Designer and choose “Campaign Monitor…” from the share menu:

You’ll be asked to enter your Campaign Monitor API key:

To add your API key:

‣ Go to the Campaign Monitor website and sign in to your Campaign Moni-
tor account

‣ Choose “Account Settings” from the menu
‣ Copy your API key
‣ Paste it into Mail Designer

Mail Designer can store your API key in your keychain, so you should only 
need to set this up once.

API Key?
In order to add new templates to your Campaign Monitor account, 
Mail Designer needs your Campaign Monitor account API key, which 
will allow it to upload templates on your behalf.
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Uploading a design to Campaign Monitor

Once your account has been configured, your designs can be uploaded to 
your Campaign Monitor account. Choose a name for your design and a client 
you want to use the design for. Afterwards click “Export”:

Your design will then be uploaded to your Campaign Monitor account. You 
can then view it on the Campaign Monitor website to see how it looks and 
use the new template in your Campaign Monitor campaigns.

Campaign Monitor Editing and Compatibility
Editing

Campaign Monitor also offers an online editing tool. However, it is usually 
easier to use Mail Designer for all editing and to simply upload your edited 
document when you’re finished.

Compatibility

When Mail Designer documents are exported to Campaign Monitor, the 
HTML formatting is re-interpreted by Campaign Monitor’s HTML engine. 

We have tested compatibility thoroughly and have strived to ensure that 
designs are exported as accurately as possible.

However, it is possible that you may see some minor discrepancies with re-
gards to the exact flow and formatting of your text (e.g. a paragraph may 
take up four lines of text instead of three) and Campaign Monitor’s editing 
preview can also sometimes display things slightly differently. 

For a more precise preview, you can use Campaign Monitor’s  build in pre-
view feature or send yourself a test message through Campaign Monitor 
once you have created your campaign, before sending it to recipients.
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Using placeholders with Campaign Monitor
Campaign Monitor can use “placeholders” in your design to automatically 
insert personalized details into your message.

To use Campaign Monitor placeholders

‣ Go to a text area within your design
‣ Right-click and choose “Insert Placeholder > Campaign Monitor “
‣ Choose the placeholder you would like to add
A placeholder will be inserted into your text, which will later be replaced 
with information from your Campaign Monitor account.

Campaign Monitor placeholders explained

Placeholder Description

Current Day Inserts the current day

Current Day Name Inserts the name of the current day 
(e.g. Monday)

Current Month Inserts the current month

Current Month Name Inserts the name of the current 
month (e.g. April)

Current Year Inserts the current year

First Name Adds the recipients first name

Full Name Adds the recipients full name

Last Name Adds the recipients last name

Recipients Email Adds the recipients email address

Unsubscribe Link Adds an unsubscribe link
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This manual covers the basic steps required to upload your design as 
a Campaign Monitor template. 

To learn more about the other Campaign Monitor features (e.g. man-
aging recipient lists, managing clients, customizing the unsubscribe 
page), please visit the Campaign Monitor support pages for detailed 
information:

→http://www.equinux.com/goto/campaignmonitorsupport

Unsubscribe Link
Any templates you want to upload to Campaign Monitor must in-
clude an unsubscribe link. 

To add an unsubscribe link to your template, please insert the Cam-
paign Monitor placeholder „Unsubscribe Link“.
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Appendix: Compatibility
While most modern email applications will display Mail 
Designer messages beautifully, there are a few email 
programs that might not always get it quite right. Here are a 
few tips…

As with all HTML-based documents, a Mail Designer message may be dis-
played slightly differently, depending on the email program being used to 
read it. 

Compatibility examples and tips

We have created a special web page with a gallery that shows what your 
readers might see when they open a Mail Designer message in their email 
application.

You’ll also find tips on how to improve compatibility and offer your readers 
alternative ways to view your messages.

→ www.equinux.com/goto/maildesignercompatibility

Basic Compatibility Tips
Backgrounds

Certain email programs (notably Outlook 2007 and 2010) have issues dis-
playing several layers of backgrounds. To maximize compatibility, assume 
that your primary background color will show up and make sure the font 
colors you choose will work with that color.

Sidebars

A sidebar layout item may not always be displayed as intended, particularly 
if it has a separate background color. You may want to place sidebar details 
in a regular layout element instead, for best compatibility.

Choosing Fonts

It's best to stick to the "web-safe" fonts. These are shown in Mail Designer by 
default when choosing a font within a layout block. If you choose another 
font, it may not be displayed on your recipient's computer as intended.

Include a compatibility link

Export your newsletter as a HTML web page and include a link to it in your 
email, allowing readers with older email clients to read your newsletter in 
their browser as you intended it to be displayed.
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Appendix: Keyboard Shortcuts

Action Shortcut

Working with ObjectsWorking with Objects

Copy Command–C

Cut Command–X

Paste Command–V

Paste with style Command–Shift–V

Duplicate Command–D

Bring Forward Option–Command–Shift–F

Bring to Front Command–Shift–F

Send Backward Option–Command–Shift–B

Send to Back Command–Shift–B

Rotate Left Option–Command–Shift–R

Rotate Right Command–Shift–R

Group Option–Command–G

Ungroup Option–Command–Shift–G

Content panelContent panel

Show layout elements Command–1

Show Graphics Command–2

Show Text Objects Command–3

Show Image Placeholders Command–4

Show Background Textures Command–5

Show Photo Browser Command–6

Action Shortcut

General ShortcutsGeneral Shortcuts

Show colors Command–Shift–C

Show Fonts Command–T

Show / hide layout Space

Show / hide Rulers Command–R

Hide Mail Designer Command–H

Hide other applications Command–Option–H

Close window Command–W

Quit Mail Designer Command–Q

Minimize Command–M

Show this manual Command–?
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